Engin 103
February 18, 2010

back to e-syllabus

Topics:

CW 3 (Cont.)
CW4

Logbook guestions

Introduction to Project 1

Systems

A system is a physical object that produces a measurable output () for every measurable input (X).

Input X
>

System

Output
—>

Y’=f(X)

Examples of a system could be a catapult (X=initial height of a weight; Y=range for a clay ball), a pendulum

(X=period; Y=length needed to produce that period), or a car on an inclined ramp (X=ramp angle; Y=distance
traveled in 2s). When random factors affecting the system are controlled (task of the engineering design team),
it can be described with an equation or model, that is, using this model it is possible to predict the output given

an input.

back

Data Modeling

Data Modeling X Y

p— System —

Y'=f(X)=Ax"2+Bx+C

Data (X.Y)
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http://www.faculty.umb.edu/tomas_materdey/103s09/files/syls09.html

Excel

Columns A. B -Enter an equation (polynomial): Columns C. D
' linear (b,c), quadratic (a.b,c), '

cubic (d,a.b,c)
-Calculate Y' (close to Y, not
exactly) for each X
-Calculate (Y'-Y)"2 (as the
deviation between modeland | columns E. F
data); obtain the 's-parameter’ '
(larger s ->worse model)
-Minimize s allowing Excel to vary
the coefficients d,a.,b.c

Project 1 requires the use of data modeling with Excel (© Microsoft), this is learned by doing CW3-CWS5, a
polynomial or exponential curve-fitting or data modeling. What is data modeling? When an input X is applied
to a system, an output Y is produced. A mathematical model of the system can be obtained by relating Y to X:
e.g. Y’=f(X). We have used a Y’ to indicate that it is not be possible in general to obtain an equation that
relates all measured Y values to all measured X values but approximate Y’ values to all measured X values.

To simplify the introduction, we discuss just simple polynomial models, e.g.

Y =aX*+bhX+c

Y’= bX+c

Y =dX3+aX?+hX+c

Y’ =exp(-b1*X)/(b2+b3*X)

How to obtain a model? Perform CW3 by following 7 steps shown in class and repeated below. The process
consists of using Solver (get it under Tools/Add-ins if needed) to minimize a “standard deviation” parameter s by
allowing the polynomial coefficients to vary. After using Solver, the final values for a, b, ¢ determine our
quadratic model that describes the pendulum. In this CW3, to save time, we will be using only 4 pairs of data,
however this is not sufficient to obtain a good model in practice: For your Project 1, please use at least 10 pairs
of data.

back
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CW3
Open Excel and type your first and last name in cell Al, today’s date in cell D1

Quadratic curve fitting with Excel:
Use Excel Solver (under Tools) to produce coefficients a,b,c for your quadratic model (y’:a*x2+b*x+c) by

n
> (v - i)
Yi = Vi
minimizing the ‘standard deviation’ s for the following set of data (S = =1 , this is not a conventional
n

standard deviation, and so it is not given by the ‘stdev’ function in Excel, but it is what we need to model our data; n is the
number of data; y’ indicates values predicted by our model; y indicates measured values given as data). Use ‘=’ to start
the formula for y’ in cell D3; click on the corresponding cells to enter the coefficients and variables into the formula (if a is
in cell C3, then click on C3, if the first x is in A3, then click on A3, etc.); remember to add a ‘$’ before and after the letter
of the cell containing the coefficients (since we don’t want these to change for the second, third, and fourth x’s); produce
similar results for cells D4-D6 by ‘copy D2 and paste’ into those; produce the squared difference formula between y’ and
y using another ‘=" in E3; etc. Produce the average of E3-E6 by writing in E7 ‘=average(E3..E6)’ and hit enter. Click on
E7 and pull out ‘Solver’ under ‘Tools’; select ‘minimum’ and in the ‘by changing’ box click and drag on the cells containing
your guesses for the coefficients. Note that after running ‘Solver’, the ‘standard deviation’ or ‘how far is our model from
the data’ is reduced to be a small number (0.1 or less, the smaller the better model you've built for those data). Watch the
movies clip ‘curve-fitting with Excel’ as you follow these instructions.

Periods x (s) Lengthsy (m)

4.5 5

6.35 10
7.75 15
9.2 20

By alphabetical order of the last names, the first two students in each team will submit file cw3_XX_a.html and
folder cw3_ XX a files, the next two students will submit file cw3_XX_b.html and folder cw3_ XX a files, to the
files folder in the server. These files need to be uploaded to the server on the due date to receive credit.

Follow these 7 steps to perform CW3:

A | B | B | D | E | A B c D | E F

| 1 |Tomas Materdey CW3 Date
| 2 |X (Periods) Y (lengths)  a,b,c guesses Sfep 1 11| Sfep 2
13 4.5 5 1+«— 23 In this column:Y' =
4| 6.35 10 0+—np 2 aX?+ bX + ¢
5| 775 15 O« ¢ . 50 .25
2 Tg'z 2? 4 “aoa22sp ) (B)
o 5 60.0625

co
% 8 84.64 PY
B X data Y data 7
110 8
L1 o

(a) In this cell type

=$C$3*A3"2 + $C$4*A3 + $C$D
This gives Y' when X is in A3 using
a quadratic model

=
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=
ES

We are going to make a quadratic

8 ]
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model for the given data (X,Y) using
Y'=aX®+bX +c
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A [ B [ ¢ | D [ E [ F |

- Step 3

In this
column:
(YY)

(b)
copy

919.45401
2030.6289
4178.3296)

(a) In this cell type =(D3-B3)"2
This gives the deviation between
the model value Y' and the data ¥
in row 3

A | B | [ | 1] | E | F | G |
(a) In A9 type 2 Step 5
(b) In A10 type =A9+0.2
| (c) Copy to A11-A47, until you get 9.6
(d) In B9 type =$C$3*A972 + $C$4*A9 +$C$5
(e) Copy to B11-B47

Czo Ca
2z © 484 ) (e)
24 C 576
1o copy

I

N 8lalsl2laslzlals =glele o oo ]

333aEan 3 en~Noanen

A ] B | ¢ [ D | E [ F ]
Step 4

In this cell:
parameter s,
the Std. Dev.
(1840.24375)

In this cell type =average(E3:E6)
This gives the parameter s, an indicator
of how far your model Y' is from the
data Y. For a given set of data,

smaller s implies better model.

26 6
28 COPY g
3 9
32 1024
34 11.56
36 1296
38 14.44
4 16
42 17.64
44 19.36
4.6 21.16
6 - =
A T ® | ¢ [ o [ € [ F [ & [ nu | 1 | 3 | K M| N [ 0 [ | me | inet | Pagelmout Fomus  Duta  Review  View
1 S T A .
2 (a) Select AQ through B47 _ _ Step 6 el ® g0 @ A
1 (b) Click on the Insert tab/Scatter/Scatter with Smooth Lines Bl e B o e N
| & (c) Right click on plot/Select Data/Click on Add (in Select Data Source) Blustsations cnans Scatter
g | {d) In Edit Series, type ‘Data (Pendulum)’ under Series Name 3 - gl 2
& | (e) Under Series X Values, click on red arrow to go to the worksheet, select A3 through AB, click on red amrow B c 1] E F

1% (g) Click OK, in Select Data Source click on Series1, then click Edit

5] (f) Under Series Y Values, click on red arrow to go to the worksheet, select B3 through BE, click on red arrow

G

Test  Head
Bex & Foe

12 (h) In Edit Series, type 'Model (Quadratic)’ under Series Name. Click OK. Click OK again in Select Data Source if
:: {i} Right click on red curve, click on Change Series Chart Type. Select XY Scatter with markers only. Click OK. 25
15 (j) Click on the Layout tab/Axis Titles/Primary Horizontal Axis Title/Title Below Axis. Type in "X (periods)’ ?g
:?. (k) Click on Axis Titles/Primary Vertical Axis Title/Rotated Title. Type in 'Y (lengths)’ 3z
18] I I I I I o 2
18] - 18
20 100 4
Fill 90 4 : 42
2 | = B EF [ Edit seri 2
3 _ nd : o Edit Series
7= ] o sees? i i - :f_d-_ - Series name:
= =5
291 o 0 e Data (Pendulum) =Data (Pendulum...
a0 - " -
) P § ¢ o Series ¥ values:
ZI:- X [peviads) =Sheet1l SAS3:SASE =45, 6.35, 7.7...
35| .
3 & Series ¥ values:
=Sheet1lSBS3:$B56 =5, 10, 15, 20
[ OK ] [ Cancel
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| (2] Select cell containing parameter s (F3) Step 7

- (b) Click the Data Tab/Click on Solver

| *Equal to: min; *By changing cells: $C$3:5C55 (for quadratic model);

| {c) In Solver Parameters make sure:Set Target Cell="$F$3'/Equal to = 'Min'/By Changing Cells="'$C$3:3C55'
1 (Type in or use red arrow to go to worksheet to select those cells). Then click Solve.

10 (d) Select "Keep Solver Solution", Then click OK,

3 (&) Observe how the model (blue) fits on the data points (pink). The parameter s changes from the

13 eriginal 1840 to a very small final value 0.024, and the guess values for a,b,c are replaced by their final values.
M. The quadratic model for this pendulum is given by ¥'=0,1337 X*2 + 1.3872 X - 4

[ P P

17 =

19
20| 2 /

[#] w1 ]
N

_,--" o Solver Parameters
2 / - —
2% z : : B3
- }‘“ . Set Target Cell: SFS3 B3 Solve
> Equal To: IMax @ Min () Vaueof: |0

2 Close
By Changing Cells:

SCE3ECES

0B b

el L Subject to the Constraints: Options
kS .
36 - e i Add
ar
Reset Al
!
Help
. . ) . . . . . } By B S S S D S = =
i o
[2 (&) Select AQ through B47 - 2 (&) Select cell containing parameter s (F3) -
2 (b) Click on "Chart Wizard™ il 2 (b) Click on Tools; Solver; check: Step7
: (c) Select XY Scatter, click Mext & “Equal to: min; "By changing cells: $C$3:$C$5 (for quadratic modsl);
& {d) Click en Series, then Add 6 (c) Click on Solve
ijn (e) Click on red arrow in X-Values, select A3 through AG in spreadsheet | o (d) Select "Keep Solver Solution™ or "Restore original values™, then OK
3 () Repeatin Y-\alues, select B3 through BE o (e) Observe how the fit curve (blue) come to lay on the data (pink)
10 (g) Click Next i
1z (h) In Value(X) Axis: type X (periods) 12
2 (@) In Value{Y} Axis: type ¥ (lenaths) 13 =
W = i 1 14
j& ) Click Next, Finish £l
1;?‘ {k} Double click on blue diamends line: check: _:u' —
:g *Line: automatic; *Weight: salect a thick line; *Marker: none :;
L3 19 159
x 100 7 3
3 9 ";’ [ sy
a2 0 e Eo —rr
pi} 1 - T
e 25 = =
X = =
7| - % .
= x < = ]
W0 v W et (2] f sheutl f Shoet2 f St f shouts f Shoots ) Sheets { Sheet? Jf Shouts [ | ¢ W v W Bhoutd (3) [ Sheetl { Sheuts { Shoats 1 Sheetd { Shoets /{ Sheatt b Sheet7 | Sheet 4 |41

Baake

FAQ:

1) What are the series?

Each series consists of two sets of numbers, one for X and one for Y. The X values
will be represented along the horizontal axis, the Y values along the vertical axis, so each
pair (x,y) is a dot on the graph.

2) Why do we need two series?

We use the data series to show the data points, and the calculated series to show the

curve or mathematical model for the data.
3) How can | add a series to a graph?
Right click on the graph, click Select Data, then click Add, then enter *Series X
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values’ and “Series Y values’.
5) How can | change the dots for the calculated series into a line?
Right click on the dots, then select Change Series Chart Type. Then select Line.
6) Where is Solver? If this is your first time using Solver, it may not be installed yet so click
on the MS icon, then select Excel Options in the bottom:

@ B AR = cw035012007 xls [Compatibility Made] - Micrasoft Excel Chart Toals TENEESNE
W View Add-Ins Design Layout Format ® - 2 X
L Recent Documents i : e
j Hew - Define Name a2 Trace P Ents ow Farmulas e ﬂ
1 cwD3s012007 xls = (= ~ St o : - e e i
i 1 Formula dents ¥ C
~ Hame Watch Calculation [
7 Open Z ot o a;;.;.g. B Create from Selection || 7, Rem r fs) Evaluate Formula | Window || Options— =
2 EECragestaly 1t T Formula Auditing Calculation
i 3 Conert 4 list103f08 xls =
= 5 studentlist.xls = (& |
: I B G H M K I M N'i
6 Summer applicants 2007 xls = |F 1 1 1 1 1 1 1 1 1
i -
"2 s parameter
= 5625 1840244
H Save As b 13,454
1.629
ik 178.33
@ Print 4

S
%7 Prepare »

[

iing for a Pendulum

;ﬁ Send ¥
Publish »
LY

_‘ Close
- — B Series2 :
123 Excel Options |X Exit Excel ‘ Vs I

U 4z oo T 20 | = - = —Seriesl

21| 44 19.36 i PP "

22| 46 21.16 a ]

23 48 23.04

2 | 5 25 o 2 4 3] ] 10 ‘2.

25 | 52 27.04 X (periods)

26 | 54 29.16

27 56 31.36

28 | 58 3364

29| [ 36

30| 6.2 35.44

M 4 » ¥| Sheetl Shest? - Sheet3 /¥ [ I

Ready

Then click on Add-ins on the left, and next to Manage, select Excel Add-ins, then click Go
(see below)
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Popular
Formulas
Proofing
Save
Advanced
Customize
© Add-Ins ol
Trust Center

Resources

View and manage Microsoft Office add-ins.

Add-ins

MName Location Type i
Acrobat PDFMaker Office COM Addin Ch.. T.00PDFMaken Office\PDFMOfficeAddin.dll - COM Add-in
Convert with FlashPaper cromedia‘FlashPaper 2\ CfficePrint4ddIn.dll  COM Add-in
Snaglt Add-in Cha N Techsmithhanaglt 8\SnagltOfficeAddindll - COM Add-in
Analysis ToolPak analys32.xl Excel Add-in
Analysis ToolPak - VBA atpvbaen.xlam Excel Add-in
Conditional 5um Wizard sumif.dam Excel Add-in
Custom XML Data Chiles\Microsoft Office’\Officel 2ZOFFRHD.DLL  Document Inspector
Date (Smart tag lists) Maniles\Microsoft Shared\Smart Tag\MOFLDOLL ~ Smart Tag
Euro Currency Tools eurotool.xlam Excel Add-in
Financial Symbaol (Smart tag lists) Chailes\Microsoft Shared\Smart Tag\MOFLDLL  Smart Tag
Headers and Footers les'\Microsoft Office\Officel 2Z0FFRHD.DLL  Document Inspector
Hidden Rows and Columns les\Microsoft Office\Officel Z0FFRHD.DLL  Document Inspector
Hidden Worksheets les\Microsoft Office\Officel ZOFFRHD.DLL  Document Inspector
Internet Assistant VBA icrosoft Office’\Officel 2\LibranAHTMLXLAM  Excel Add-in
Invisible Content Chailes\Microsoft Office’\Officel ZOFFRHD.DLL  Document Inspector
Lookup Wizard lookup.xlam Excel Add-in =
Person Mame [CQutlook e-mail recipients) Chanes\Microsoft Shared\Smart Tag\FNAMEDLL ~ Smart Tag
Solver Add-in solver.xlam Excel Add-in

N &

Ch\Program Files\Adobe\Acrobat 7.00PDFMaker\Office\ POFMOfficeAddin.dll

Add-in: Acrobat PDFMaker Office COM Addin
Publisher: Adobe Systems, Incorporated
Location:

Description:  Acrobat PDFMaker Office COM Addin

Manage: QE<IEN ST L

OK ][ Cancel ]

Make sure Solver Add-in is checked in the next window. And click Yes to any error

message
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Add-Ins

add-Ins available:

Solver Add-in

[ | analysis ToolPak, O

[ ] analysis ToolPak - VEA

[ ] conditional Sum Wizard

:| Euro Currency Tools

[ ]Internet Assiskant YEA
B .

[ Lookup Wizard 2

Aukomation, ..

Solver Add-in

Tool for optimization and equation solving

Microsoft Office Ex

' Micrasaft Office Excel can't run this add-in,
. This feature is not currently installed, Would you like toinstall it now?

Excel will then install Solver, it takes a couple of minutes, be patience.
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i_ Microsoft Office Professional Plus 2007

@;:U Configuration Progress

(RENRNARNARNER 1

Configuring Microsoft Office Professional Plus 2007...

Then under the Data tab you will see Solver on the right (see below)

Engin 103 Class Notes —Spring ‘10 9-17



‘/Cl_j = 2 cw03s0I2007 xls [Compatibility Mode] - Micrasoft Excel Chart Toals - 8 Xx
a
- Home Insert Page Layout Farmulas Data Review View Add-Ins Design Layout Faormat @ - = X
- From Access ! _| Connections ,l A & Clear = < Group E ?,,, Solver
b - Properties ) - = a4 Ungroup - =%
From Other Existing Refresh . ‘ l Sort Filter L Rem r
7] From t Sources Connections All =3 Edit Links 2 .52 Advanced || Columns Duplicate B| Subtotal
Get External Data Connections Sort & Filter Da ools Qutline Analysis
| Chart 3 - £
| A B c D | E | F | G H J | K | L | M | N 'i
1 |Tomas Materdey
2 |x (Periods) y (lengths) ab.c guesses y'=ax'@+bx+c (y-y)p"2 5 parameter
3| 45 20.25 2325625 1540.244
4 6.35 10 0 40.3225 919454
5 T 15 0 600625 2030629
6 27 20 8464 4178.33
4
8
-, 2 4 ;
10 2.2 4.84 =
gl 24 5.76 Data Modeling for a Pendulum
12| 26 6.76
13 28 T84 100
14 3 9 a0 7
15| 3.2 10.24 oo 4
16| 34 11.56 - L P
17 36 12 96 20 0 =
18 kR 14.44 H 7 ] s
| = 40 B
19 4 16 = n / B Series2
20 42 17.64 o - - Seriesl
21 44 19.36 o ~ g B
2| 45 21.16 £ |
23 48 23.04
24 | 5 25 o 2 4 6 g 10 1z
25 52 27 04 X [periods)
26 | 54 29.16
27| 5.6 31.36
28 | 58 33.64
29 6 36
30 6.2 3544
4+ ¥ Sheetl Shest - Sheets ~¥J 4 [ m

Ready

7) What do we use Solver for?

This is the heart of the data modeling process, we use Solver to obtain the model for
the measured data. How to obtain a model? The process consists of using Solver (get it
under Tools/Add-ins if needed) to minimize a “standard deviation” parameter s by allowing
the polynomial coefficients a, b, ¢ to vary.

Y'=axX®+bX +c
Starting with your guesses, Solver varies a, b, ¢ until the s parameter, contained in cell $F$3
and which is the average of the deviations (Y-Y)?, is minimum. When this is achieved, the
final values for a, b, ¢ determine our polynomial (quadratic) model for the measured data.

In this CW3, to save time, we used only 4 pairs of data, however this is not sufficient to
obtain a good model in practice, for your Project 1, please use at least 10 pairs of data.

8) Why my data points are far from the curve after using Solver?
Make sure you select the Minimize option and not the Maximize option. See below.
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Solver Parameters

Set Target Cell: $F$3 k., Solve

Equal To: " Max & Mo ( WYalueof: |0
By Changing Cells:

[$C$3:4CH5] Y GUess

Subject ko the Constraints: Cptions

-] Add
Change
J Delete

Close

Reset all

i

Help

8) What should I submit for CW3?
The Spreadsheet you submit for the quadratic model should look like this

Tomas Materdey

¥ (Perinds) y (lengths) ab.cguesses  y=awl+hi+c (y-yp2
45 0.133672117 4.945402062 0.002662 0.024125
| B.35 10 1387171924 10.19780371 0.039126 I _l
775 15 -4.000731949 14776532 0.049048
92 20 2007525775 0.005664

2 -DE91E99E32
22 -0.301980669

24 00584E0E1 | /

26 0509536566

28 0931338837
3 1.363932878

32 1607000868 | 15

54 2260002267 | / —

36 2726477616 | @

38 3200746734 | S0 —series]
4 3686709622 %

42 4183366279
44 4630716705
46 5208760901
4.8 5737493866

N

5 6.2769306
52 B.827056104
54 7387875377 e 4 & g 10 12

66 7959386419
58 8.541595231

6 9.134435313 X (periods)
6.2 9733020163

&

back

Cw4

(@)

Save CW3 into a new file, then in Sheet #1 modify it to produce a linear and a cubic
model for the same data set, insert snapshots of these worksheets into Table 1 in a MS
Word file. Make a table like the one below for the “s” values for the linear, quadratic, and
cubic models, along with the coefficients obtained for each model. Indicate which is the
best model (linear, quadratic, or cubic) for our set of data, and explain why.

Model Coefficients S parameter
.| A:
— B=
;{ c=
Linear = = D=
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Table 1: All terms in polynomial models using same data set as in CW3

(b)

Download this data set, repeat the table above for this new data set: (i) In
Sheet#2 using all terms in each polynomial model. Insert spreadsheet snapshots,
polynomial coefficients, and parameter s into Table 2 in your MS Word file (ii) In Sheet #3
using only the highest order term in each polynomial model. Insert spreadsheet
snapshots, polynomial coefficients, and parameter s into Table 3 in your MS Word file.
Can you conclude what is the dominant relationship (linear, quadratic, or cubic) between
the periods and the lengths of a pendulum?

Model (all terms) Coefficients S parameter

A=
B=
C=
D=

Linear....==

Quadratic .-~

Table 2: All terms in polynomials models using new data set

Model (only leading terms) | Coefficients | S parameter
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http://www.faculty.umb.edu/tomas_materdey/103f07/files/cw4bdata.html

s A=

il B=

= o=

|k B : —

8E b=
Linear:. i 5= :

i e m A=

SRa- B=

P C=

e 0 e _

S -'_.;.4- - & =

Quadratict...2. 5= .

s . '. cafiEh =

PR B=

=B = . _

| || — D=
Cubick.Li . F= :

Table 3: Only highest order term in polynomial models using new data set

In each team, students working together at a computer numbered between 1 and 10 will
submit file cw4_ XX a.html and folder cw4 XX a files, students working at a computer
numbered between 11 and 20 will submit file cw4_XX_b.html and folder cw4_XX b _files, to

the files folder in the server. Replace XX by 01 if team 1, etc. Include your names
within the files.

Q&A
1) What is the purpose of CW4?

The purpose is to modify the Excel Spreadsheet we created for CW3 to apply a
cubic and linear model to the same set of data. After assembling a table with the s
parameters and coefficients for the three models, we will be able to determine the best
model for a given set of data. This is something you should do for part Il of Project 1.

2) How many coefficients are there in these different models?

Cubic polynomial:
Y’=f(X)= D*X3 + A*X? + B*X + C (has 4 coefficients: D, A, B, C)

Quadratic polynomial:
Y’'=f(X)= A*X* + B*X + C ( has 3 coefficients: A, B, C)

Linear polynomial:
Y’=f(X)=B*X + C ( has 2 coefficients: B, C)

3) How can | get a snapshot of the worksheet?
Copy a snapshot of the Excel screen by doing ALT+PRINT SCREEN, then
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PASTE into a WORD file
4) What a §preadsh::—><ifqr a cubic model would look like?

« o)

5) What a spreadsheet for a linear model would look like?

VTN St [ S a4 T Le

What changes should | make to the CW3 spreadsheet to produce a cubic model?
Here are the changes (in green) to make to the spreadsheet for CW3 to apply a

cubic model for CW4a)

A B C D E

1 Your nhame 10/19/2004

2 | X (Periods)Y (lengths) a,b,c, d guesses S‘I‘ep 1
3 4.5 5 1le——4d

4 6.35 10 o«—12>,

5 7.75 15 0«— O
% 9.2 20 ol«— gxtra cubic
8 T T parameter 'd
190 X Y

1 data data

12

13 .

14« We are trying to relate X to Y

15

. 3 2
16 using Y'= dX"+aX"+bX + ¢
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A B Cc D E F
In this column:Y' = S']'ep 2
2 dX’ +aX*+ bX + ¢
3
(b)
4 40.3225
copy
5 60.0625
6 84.64
7
8 .
9 (a) Inthis cell type
10
1 = +$CH3*A3N2 + $CHA*A3 + $C$5
1= This gives Y' when X is in A3 using a
14 i
) _polynor‘mal
A B Cc D E F
1 v (a) In A9 type 2 Step 5
(b) In A10 type =A9+0.2
, (€) Copy to Al1-A47, until you get 9.6
3 (d)InB9type =
4
5 +$CH3*AIMN2 + $CH4*A9 +$C$5
6
7 (e)
o T
9
10 4.84 (e)
11 24 (c) 5.76
112 ] 2.6 copy 676 |
13 2.8 7.84
14 3 9
T A "B C 5 E F G H 1 J
1
(a) Select cell containing parameter s (F3) ST@P 7
2 |(b)-Click on Tools; Solver; check:
3 *Equal'to: min; *By changing cells: $C$3:
5 (c) Click on Solve
8 (d) Select "Keep Solver Solution" or "Restore original values”, then OK
L(e) Observe how the fit curve (blue) come to lay on the data (pink)
WBU 25
i
12 " /
[E] /
14
15
16 75
. /
5 =0 /
21
2
. T
%5
& n

6) How to get a QUADRATIC model using the spreadsheet made for a CUBIC
model?

7) How to get a Linear model using the spreadsheet made for a CUBIC model?
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LOGBOOK: example of a logbook page

-Use a quadrille notebook; number all pages; date all entries

-Write your notes for all activities, thoughts, problems and solutions, and learning conclusions related to
Engin 103. You should write down progress, outcomes, and conclusions on projects and teamwork;
conclusions from class work (including LabVIEW) and homework.

-In addition you should answer in the logbook all questions listed in these notes in blue, as shown below:

13) Create a flow chart to show the supply chain of an automobile from the raw materials to the end
consumer. The chain should include at least 6 steps: 1) Raw materials 2) 3) 4) 5)

6) Consumer. In each step, indicate what type of engineers from the table below would be involved. In a
few words explain what they do specifically. Can you include all ten fields in the supply chain?

. Engineering fields Abbreviations
Raw materials Aeronautical and Aerospace AAE

Engineering
Biomedical Engineering BME

iL Chemical Engineering ChE
Civil Engineering CiE
Computer Engineering CE
Electrical Engineering EE
Geological/Geophysical GGP

iL Engineering
Industrial and IME
Manufacturing Engineering
Material Science MSE
Engineering

iL Mechanical Engineering ME

11

11

Consumer

14) Sketch the Engineering Design Cycle in your logbook, explain specific actions to be taken by you and
your team for Project 1 as related to the different steps in the cycle. Be as specific and as detailed as

Engin 103 Class Notes —Spring ‘10 16-17



http://www.faculty.umb.edu/tomas_materdey/e103/files/lbex1.pdf

possible.

15) Explain in your own words, steps 1-4 on how to prepare an Excel spreadsheet to obtain the
model/equation describing a system. In other words, explain what to do in columns A to E in the
spreadsheet. Be as detailed as possible.

16) Explain why when implementing the quadratic model in cell D3: =$C3$3*A3/2+$C$4*A3+$C$5
we used a $ before and after the C, but not for A
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